
Contents for Server Manager Help

Introduction
 Server Manager Overview

How To...
 Manage the View
 Manage Server Properties
 Manage Shared Directories
 Manage Services 
 Send a Message to Connected Users
 Manage a Domain

Commands
 Computer Menu Commands 
 View Menu Commands 
 Options Menu Commands 



Contents for Server Manager Help

Introduction
 Server Manager Overview
 What Is Server Manager?
 The Server Manager Window
 Who Can Use Server Manager?
How To...
 Manage the View
 Selecting a Domain
 Displaying Servers, Workstations, or Both
 Displaying Domain Members Only
 Refreshing the View
 Using Low Speed Connection
 Manage Server Properties
 Managing Server Properties
 Viewing User Sessions
 Viewing Shared Resources
 Viewing Resources In Use
 Managing Export Replication
 Managing Import Replication
 Setting the Logon Script Path
 Managing Administrative Alerts
 Manage Shared Directories
 Viewing Shared Directories
 Sharing a Directory
 Managing Properties for a Shared Directory
 Setting Permissions for a Shared Directory
 Stopping Directory Sharing
 Manage Services
 Starting and Stopping Services
 Configuring Service Startup
 Assigning a Logon Account to the Directory Replicator Service
 Assigning a Logon Account to the Schedule Service
 Send a Message to Connected Users
 Sending a Message to Connected Users
 Manage a Domain
 Promoting a Backup Domain Controller to Primary Domain Controller
 Demoting a Primary Domain Controller to Backup Domain Controller
 Synchronizing a Backup Domain Controller with the Primary Domain Controller
 Synchronizing All Servers of the Domain
 Adding a Computer to the Domain
 Removing a Computer from the Domain
 Changing a Computer Name
Commands
 Computer Menu Commands
 Properties
 Shared Directories



 Services
 Send Message
 Promote to Primary Domain Controller
 Demote to Backup Domain Controller
 Synchronize with Primary Domain Controller
 Synchronize Entire Domain
 Add to Domain
 Remove from Domain
 Select Domain
 Exit
 View Menu Commands
 Servers
 Workstations
 All
 Show Domain Members Only
 Refresh
 Options Menu Commands
 Low Speed Connection
 Save Settings on Exit
 Font



Contents for Server Manager Help

Introduction
 Server Manager Overview
 What Is Server Manager?
 The Server Manager Window
 Who Can Use Server Manager?
How To...
 Manage the View
 Manage Server Properties
 Manage Shared Directories
 Manage Services 
 Send a Message to Connected Users
 Manage a Domain
Commands
 Computer Menu Commands 
 View Menu Commands 
 Options Menu Commands 



Contents for Server Manager Help

Introduction
 Server Manager Overview
How To...
 Manage the View
 Selecting a Domain
 Displaying Servers, Workstations, or Both
 Displaying Domain Members Only
 Refreshing the View
 Using Low Speed Connection
 Manage Server Properties
 Manage Shared Directories 
 Manage Services 
 Send a Message to Connected Users
 Manage a Domain
Commands
 Computer Menu Commands 
 View Menu Commands 
 Options Menu Commands 



Contents for Server Manager Help

Introduction
 Server Manager Overview
How To...
 Manage the View 
 Manage Server Properties
 Managing Server Properties
 Viewing User Sessions
 Viewing Shared Resources
 Viewing Resources In Use
 Managing Export Replication
 Managing Import Replication
 Setting the Logon Script Path
 Managing Administrative Alerts
 Manage Shared Directories 
 Manage Services 
 Send a Message to Connected Users
 Manage a Domain
Commands
 Computer Menu Commands 
 View Menu Commands 
 Options Menu Commands 



Contents for Server Manager Help

Introduction
 Server Manager Overview
How To...
 Manage the View 
 Manage Server Properties
 Manage Shared Directories
 Viewing Shared Directories
 Sharing a Directory
 Managing Properties for a Shared Directory
 Setting Permissions for a Shared Directory
 Stopping Directory Sharing
 Manage Services 
 Send a Message to Connected Users
 Manage a Domain
Commands
 Computer Menu Commands 
 View Menu Commands 
 Options Menu Commands 



Contents for Server Manager Help

Introduction
 Server Manager Overview
How To...
 Manage the View 
 Manage Server Properties
 Manage Shared Directories 
 Manage Services
 Starting and Stopping Services
 Configuring Service Startup
 Assigning a Logon Account to the Directory Replicator Service
 Assigning a Logon Account to the Schedule Service
 Send a Message to Connected Users
 Manage a Domain
Commands
 Computer Menu Commands 
 View Menu Commands 
 Options Menu Commands 



Contents for Server Manager Help

Introduction
 Server Manager Overview
How To...
 Manage the View 
 Manage Server Properties
 Manage Shared Directories 
 Manage Services 
 Send a Message to Connected Users
 Sending a Message to Connected Users
 Manage a Domain
Commands
 Computer Menu Commands 
 View Menu Commands 
 Options Menu Commands 



Contents for Server Manager Help

Introduction
 Server Manager Overview
How To...
 Manage the View 
 Manage Server Properties
 Manage Shared Directories 
 Manage Services 
 Send a Message to Connected Users
 Manage a Domain
 Promoting a Backup Domain Controller to Primary Domain Controller
 Demoting a Primary Domain Controller to Backup Domain Controller
 Synchronizing a Backup Domain Controller with the Primary Domain Controller
 Synchronizing All Servers of the Domain
 Adding a Computer to the Domain
 Removing a Computer from the Domain
 Changing a Computer Name
Commands
 Computer Menu Commands 
 View Menu Commands 
 Options Menu Commands 



Contents for Server Manager Help

Introduction
 Server Manager Overview
How To...
 Manage the View 
 Manage Server Properties
 Manage Shared Directories
 Manage Services 
 Send a Message to Connected Users
 Manage a Domain
Commands
 Computer Menu Commands
 Properties
 Shared Directories
 Services
 Send Message
 Promote to Primary Domain Controller
 Demote to Backup Domain Controller
 Synchronize with Primary Domain Controller
 Synchronize Entire Domain
 Add to Domain
 Remove from Domain
 Select Domain
 Exit
 View Menu Commands 
 Options Menu Commands 



Properties

Manages the server properties of the selected computer.    Use this command to display a 
summary of connections and resource use; to view a list of connected users, shared 
resources, and open resources; and to manage the computer description, directory 
replication, the logon script path, and the list of administrative alert recipients.
See Also
Managing Server Properties



Shared Directories

Manages shared directories on the selected computer.    A shared directory can be accessed
by network users.    Use this command to share, stop sharing, modify properties, and 
manage permissions for shared directories.
See Also
Viewing Shared Directories
Sharing a Directory
Managing Properties for a Shared Directory
Setting Permissions for a Shared Directory
Stopping Directory Sharing



Services

Manages services.    Use this command to stop, start, pause, continue, pass startup 
parameters to, and configure startup for services.
See Also
Starting and Stopping Services
Configuring Service Startup



Send Message

Sends your message to all users connected to the selected computer.
For a message to be sent and received, the Messenger service must be running on the 
computer sending the message and on the computers receiving the message.
See Also
Sending a Message to Connected Users



Promote To Primary Domain Controller

Promotes the selected server to primary domain controller.    If it is available, the previous 
primary domain controller is automatically demoted to backup domain controller status.
This command is only available when Server Manager displays a domain, and a backup 
domain controller is selected. 
See Also
Promoting a Backup Domain Controller to Primary Domain Controller
Demoting a Primary Domain Controller to Backup Domain Controller



Demote to Backup Domain Controller

Usually, when a server is promoted to primary domain controller no special action needs to 
be taken to demote the former primary domain controller to backup domain controller 
status, because the system does this automatically.
However, if a server is promoted to primary domain controller while the existing primary 
domain controller is unavailable (for example, if it is being repaired), and if the former 
primary domain controller later returns to service, you must demote it.
When a former primary domain controller returns to service under this circumstance, and is
selected in the Server Manager window, the Promote To Primary Domain Controller 
command becomes the Demote To Backup Domain Controller command.    Until it is 
demoted, the former primary domain controller does not run the Net Logon service, does 
not participate in authenticating user logons, and in the Server Manager window its 
controller icon is dimmed.
See Also
Promoting a Server to Primary Domain Controller
Demoting a Primary Domain Controller to Server



Synchronize with Primary Domain Controller

This command is only available when a backup domain controller is selected.
When a server running Windows NT Server is selected, this command replicates the 
domain's security database from the primary domain controller to that server. When a LAN 
Manager 2.x server is selected, this command reestablishes the server's computer account 
password between that server and the primary domain controller. Note that you can 
synchronize a LAN Manager 2.x server only with a LAN Manager 2.x primary domain 
controller; you cannot synchronize a LAN Manager 2.x server with a Windows NT Server 
primary domain controller.
Synchronization is usually done automatically by the system, but if the security database 
on a Windows NT Server backup domain controller becomes unsynchronized, or if a LAN 
Manager 2.x server is unable to establish network connections, this is a manual way to 
correct the situation.    It is rarely necessary.
See Also
Synchronizing a Server with the Primary Domain Controller
Synchronizing All Servers of the Domain



Synchronize Entire Domain

This command is only available when the primary domain controller is selected.    It 
replicates the domain's security database from the primary domain controller to all the 
backup domain controllers in the domain.
This is usually done automatically by the system, but if the security databases become 
unsynchronized, this is a manual way to correct the situation.    It is rarely necessary.    It can
take a substantial amount of time to complete.
See Also
Synchronizing All Servers of the Domain
Synchronizing a Backup Domain Controller with the Primary Domain Controller



Add to Domain

Before a Windows NT computer can be a domain member and participate in domain 
security, it must be added to the domain.    Computers that are added to a domain are 
given accounts in the domain's security database.    There are three ways to add computers
to a domain, but only one of them requires Server Manager.    That method uses the Add To 
Domain command.

A computer can be added to a domain during installation of Windows NT,    but only 
when the installation is performed by a domain Administrator.

An Administrator can add an existing Windows NT computer to a domain using the 
Network option of that computer's Control Panel.

Or, an Administrator or an Account Operator can use Server Manager's Add To 
Domain command to add a computer account to the domain's security database.    Then the 
computer's user must have the computer join the domain under that computer account.    
This can be accomplished by a user as part of Windows NT installation; or, for any computer 
other than primary or backup domain controllers, after installation by using the Network 
option in Control Panel.
Note: Treat the added computer name as a security element.    Until the intended 

computer joins the domain, it is possible for a user to give a different computer that 
computer name, and then have it join the domain using the computer account you 
have just created.    If the added computer is a server, when it joins it receives a 
copy of the domain's security database.

See Also
Adding a Computer to the Domain



Remove from Domain

Removes the selected computer from the domain.    The computer's account is deleted from
the domain's security database, and it can no longer participate in domain security. 
The primary domain controller cannot be removed.
See Also
Removing a Computer from the Domain



Select Domain

When Server Manager starts it displays your logon domain.    Use the Select Domain 
command to display a different domain, a Windows NT workgroup, or an individual 
computer.
See Also
Selecting a Domain
Using Low Speed Connection
Who Can Use Server Manager?



Exit

Quits Server Manager.
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Servers

Displays only servers in the Server Manager window.    Workstations are filtered from the 
display, and are not shown.    
When Servers is enabled, a check is displayed on the View menu to the left of the 
command, and (Servers) appears on the Server Manager title bar.
See Also
Displaying Servers, Workstations, or Both



Workstations

Displays only workstations in the Server Manager window.    Servers are filtered from the 
display, and are not shown.    
When Workstations is enabled, a check is displayed on the View menu to the left of the 
command, and (Workstations) appears on the Server Manager title bar.
See Also
Displaying Servers, Workstations, or Both



All

Displays both servers and workstations in the Server Manager window.    When All is 
enabled, a check is displayed on the View menu to the left of the command.
See Also
Displaying Servers, Workstations, or Both



Show Domain Members Only

By default, the list of computers displayed in the Server Manager window contains 
computers that are members of the domain, plus computers that the Computer Browser 
service reports as active on the domain.    
The Show Domain Members Only command filters the display so that the list is composed 
of only those computers that are actual members of the domain: computers running 
Windows NT. When this command is enabled, a check is displayed on the View menu to the 
left of the command.
See Also
Displaying Domain Members Only



Refresh

When Server Manager starts, and every time the Select Domain command is issued, Server
Manager receives information necessary to create the computer list displayed in the Server
Manager window.    The information is refreshed (updated with current data) after some 
other Server Manager functions, such changing computer properties, managing services, or
promoting a server to primary domain controller.    (These refreshes do not occur when the 
Low Speed Connection option has been selected.)
A refresh can be initiated by a user, using the Refresh command from the View menu.
See Also
Refreshing the View
Using Low Speed Connection
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Low Speed Connection

When administering a domain, workgroup, or computer that communicates with your 
computer across a connection providing relatively low transmission rates, choose the Low 
Speed Connection option.    This prevents automatic refresh of the Server Manager screen, 
which may be time consuming when performed across low speed connections. (Refreshes 
occur automatically after some Server Manager functions, such changing computer 
properties, managing services, or promoting a server to primary domain controller.)    When 
this option is enabled, a check is displayed on the Options menu to the left of the 
command.
In Low Speed Connection mode the Server Manager screen can still be be refreshed 
manually by choosing the Refresh command from the View menu.
Low Speed Connection can also be selected (or cleared) from the Select Domain dialog box,
at the same time you select a domain, workgroup, or computer to be displayed by Server 
Manager.
See Also
Using Low Speed Connection
Selecting a Domain



Save Settings On Exit

When you quit Server Manager, if the Save Settings on Exit command from the Options 
menu is enabled (indicated by a check to the left of the command) the main window size 
and position and the View menu settings are saved.



Font

Changes the font used for the list of computers in the Server Manager main window.



Contents

Lists Server Manager Help topics.



Search for Help On

Presents an index of keywords from Server Manager Help.    Associated Help topics can be 
listed, selected, and opened.



How to Use Help

Provides introductory information about accessing and using the online Help system.



About Server Manager

Provides the version number, serial number, copyright, licensing, and other information 
about Microsoft Windows NT Server Manager.



What Is Server Manager?

Server Manager is a tool you can use to manage domains and computers.    With Server 
Manager you can:

Select a domain, workgroup, or computer to be administered.
Manage a computer    For a selected computer you can view a list of connected users,

view shared and open resources, manage directory replication, manage the list of 
administrative alert recipients, manage services and shared directories, and send messages 
to connected users.    

Manage a domain.    When administering a domain you can promote a backup domain
controller to become the primary domain controller, synchronize servers with the primary 
domain controller, and add computers to and remove computers from the domain.
Some of the capabilities offered by Server Manager are also offered by the Services and 
Server options in the Control Panel of every Windows NT computer.    However, Server 
Manager can manage both local and remote computers, while these Control Panel options 
only affect the local computer.



The Server Manager Window

In most cases, when Server Manager is first started it displays your logon domain. The 
Server Manager title bar shows the domain name, and the body of the Server Manager 
window lists the computers of that domain. A computer can be selected from this list, and 
can then be managed using commands from the Computer menu.
Choose one of the following buttons for more information about the Server Manager 
window.
 Title bar
 Menu bar
 List of computers
 Computer icons
 Computer column
 Type column
 Description column



Title bar

The title bar of the Server Manager window names the domain, workgroup, or computer 
that is displayed for administration.    
When filtering is enabled using commands from the View menu, a notation of (Servers) or 
(Workstations) is displayed on the title bar to the right of the domain, workgroup, or 
computer name.



Menu bar

The menu bar contains four menus.
Computer.    Commands from this menu are used to view and manage domains, 

workgroups, and computers.
View.    Commands from this menu are used to filter the displayed list of computers, 

to remove filtering, and to update Server Manager with current information.
Options.    Commands from this menu can select or clear the Low Speed Connection 

and Save Settings on Exit options.
Help.    Commands from this menu provide online Help.



List of computers

The body of the Server Manager window lists the computers of the domain selected for 
administration (that is, the domain whose name is displayed in Server Manager's title bar).  
This list contains computers that are members of the domain, plus computers that the 
Computer Browser service reports as active in the domain.    
The list can contain these kinds of computers:    servers running Windows NT Server, 
Windows NT Workstation computers that are running the Server service, and Microsoft LAN 
Manager servers.    Microsoft Windows for Workgroups computers might also appear in the 
list, but because they do not support remote administration they cannot be administered 
with Server Manager.
When a Windows NT workgroup is selected for administration, the computers of that 
workgroup are listed.    When an individual computer is selected for administration, only 
that computer is listed.    The list of computers can be filtered using commands from the 
View menu.



Computer icons

An icon graphically indicates the type of each listed computer.
Primary Domain Controller.    Maintains the domain's security database, and 

authenticates network logons.
Backup Domain Controller or Server.    Backup domain controllers receive a copy of 

the domain's security database and authenticates network logons. Servers in the domain 
can use the domain's user accounts through pass-through authentication.

Workstation.    Any other listed computer.
If a computer does not support remote administration, or if it is unavailable to the network 
(for example, if it is turned off), its icon is dimmed.



Computer column

For each listed computer, this column provides the computer name.



Type column

For each listed computer, this column states the operating system, the version number of 
the operating system, and whether the computer is a primary domain controller, backup 
domain controller, server, or workstation.    
For example, a computer might be shown as a Windows NT 3.50 Primary.
If a computer does not support remote administration, or if it is unavailable to the network 
(for example, if it is turned off), the version number is absent from this column.



Description column

For each listed computer, this column might contain descriptive text or it might be blank.
For each listed computer, the description is an optional entry.    It can be edited using the 
Properties command from the Computer menu.    It might typically contain such information
as the location of the computer, the name of the computer's user, the user's telephone 
extension, the brand or model of the computer, or a description of the computer's function. 
If a computer does not support remote administration, or if it is unavailable to the network 
(for example, if it is turned off), its description is blank.



Who Can Use Server Manager?

To use Server Manager to administer a domain and its servers, you must be logged on to a 
user account that is a member of the Administrators, Domain Admins, or Server Operators 
group for that domain.    Members of the Account Operators group can also use Server 
Manager, but only for the purpose of adding computers to the domain.
To use Server Manager to administer a Windows NT Workstation computer or a server that 
is not a domain controller, you must be logged on to a user account that is a member of 
the Administrators or Power Users group for that computer. 
A few Server Manager functions are only allowed for Administrators or Domain Admins.    
When Server Operators, Account Operators, or Power Users attempt to perform these 
functions, a message is displayed indicating that access is denied.



Selecting a Domain

In most cases, when Server Manager starts it displays your logon domain.    Use the Select 
Domain command to display a different domain, a Windows NT workgroup, or an individual 
computer.
A domain is a collection of computers that are grouped for viewing purposes and that share
a common security database.    A workgroup is a collection of computers that are grouped 
only for viewing purposes.
To change the domain displayed by Server Manager
1. From the Computer menu, choose Select Domain.
2. Select a domain from the list in the Select Domain list box, or type a domainname in 

the Domain box.
Optionally, to specify a Windows NT workgroup instead of a domain, type a 
workgroupname in the Domain box.    To specify an individual computer, type the \\
computername (precede computer names with two backslashes).

3. If the domain, workgroup, or computer you have specified communicates with your 
computer over a low speed connection, select the Low Speed Connection option.
The system saves the setting of this option for each of the last 20 domains, 
workgroups, or computers you have administered.    After you specify a name, the 
previous setting of this option (if any) is initially displayed here.    If no previous setting 
is known, the option is initially cleared.    You can accept or change the setting.

4. Choose the OK button.

See Also
Who Can Use Server Manager?
Using Low Speed Connection



Displaying Servers, Workstations, or Both

By default, the list of computers in the Server Manager window includes both servers and 
workstations.    Optionally, you can filter the list and display only one of those types.
To display only servers

From the View menu, choose Servers.    
A notation of (Servers) is displayed on the title bar, and on the View menu a check is 

displayed to the left of the Servers command.
To display only workstations

From the View menu, choose Workstations.    
A notation of (Workstations) is displayed on the title bar, and on the View menu a 

check is displayed to the left of the Workstations command.
To display both servers and workstations

From the View menu, choose All.



Displaying Domain Members Only

By default the list of computers displayed in the Server Manager window contains those 
computers that are members of the domain, plus those computers that are listed by the 
Computer Browser service as active in the domain.    Optionally, you can filter the list to 
display only those computers that are members of the domain. This will be Windows NT 
computers and LAN Manager 2.x servers.
To display only those computers that are members of the domain

From the View menu, choose Show Domain Members Only.    
A check is displayed on the View menu, to the left of the Show Domain Members Only

command.    
To remove filtering and display all computers

From the View menu, choose Show Domain Members Only.
The check at the left of the Show Domain Members Only command is removed.



Refreshing the View

When Server Manager starts, and every time the Select Domain command is issued, Server
Manager receives the information necessary to create the computer list displayed in the 
Server Manager window.    The information is refreshed (updated with current data) after 
some Server Manager functions, such as changing computer properties, managing 
services, or promoting a server to primary domain controller. However, these refreshes do 
not occur when the Low Speed Connection option is selected.
A refresh can also be initiated by a user.
To refresh the view with current information

From the View menu, choose Refresh.
See Also
Using Low Speed Connection



Using Low Speed Connection

When administering a domain, workgroup, or computer that communicates with your 
computer across a connection providing relatively low transmission rates, use the Low 
Speed Connection option.    This prevents automatic refresh of the Server Manager screen, 
which may be time consuming when performed across low speed connections. (Refreshes 
occur automatically after some Server Manager functions, such changing computer 
properties, managing services, or promoting a server to primary domain controller.)
Here are two ways to select or clear the Low Speed Connection option:

When you have chosen the Select Domain command from the Computer menu and 
you are selecting a domain, Windows NT workgroup, or computer to be displayed by Server 
Manager, you can select or clear the Low Speed Connection option in the Select Domain 
dialog box.

When a domain, Windows NT workgroup, or computer is already displayed by Server 
Manager, you can select or clear the Low Speed Connection option by choosing the Low 
Speed Connection command from the Options menu.
The system saves the setting of the Low Speed Connection option for each of the last 20 
domains, workgroups, or computers you have administered.    After you specify a name in 
the Select Domain dialog box, the previous state of this option (if any) is initially set.    You 
can accept or change this setting.
If you have not previously administered the specified domain, workgroup, or computer, and
if you do not select the Low Speed Connection option in the Select Domain dialog box, after
you choose the OK button the system automatically determines the appropriate connection
mode and selects or clears the Low Speed Connection option accordingly.    After connection
you still have the option of changing the setting by using the Low Speed Connection 
command from the Options menu.
Also, when starting Server Manager from the command prompt, you can optionally append 
the low speed connection parameter [/l] or the normal (high speed) connection parameter 
[/h].    For example, to start Server Manager and administer the domain Shipping using Low 
Speed Connection, you would type srvmgr shipping /l.
See Also
Selecting a Domain
Refreshing the View



Managing Server Properties

To manage properties
1. In the Server Manager window, double-click a computer name.

The Properties dialog box appears, displaying a summary of connections and resource 
usage.

2. To change the computer description, type new text in the Description box.
3. To administer a property associated with one of the buttons at the bottom of the 

Properties dialog box, choose a button and complete the dialog box for that property.
There are five buttons:    Users, Shares, In Use, Replication, and Alerts.

4. When you finish managing properties, choose the OK button in the Properties dialog 
box.

See Also
Viewing User Sessions
Viewing Shared Resources
Viewing Resources In Use
Managing Export Replication
Managing Import Replication
Setting the Logon Script Path
Managing Administrative Alerts



Viewing User Sessions

To view a list of users connected to the computer
1. In the Server Manager window, double-click a computer name.
2. In the Properties dialog box, choose the Users button.

The User Sessions dialog box appears.    The Connected Users box lists the users who 
are connected over the network to the computer.

3. To view the resources opened by one user, select a user name from the Connected 
Users box. 
The Resource box lists the shared resources that user is connected to. 

4. Optionally, to disconnect one user, select the user name from the Connected Users box
and then choose the Disconnect button.    To disconnect all users, choose the 
Disconnect All button.    Warn connected users before disconnecting them.

Note: While you are remotely administering another computer, your user account will be 
listed as a user connected to the IPC$ resource.    It cannot be disconnected.

5. To exit choose the Close button, and then in the Properties dialog box choose the OK 
button.

See Also
Viewing Shared Resources
Viewing Resources In Use
Special Shares



Viewing Shared Resources

Use the Shared Resources dialog box to view the shared resources available on the 
computer, and the users connected over the network to a selected shared resource.
Note: To share directories or manage shared directories, use the Shared Directories 

command from Server Manager, or use File Manager.    To share printers or manage 
shared printers, use Print Manager.

To view a list of the computer's shared resources
1. In the Server Manager window, double-click a computer name.
2. In the Properties dialog box, choose the Shares button.

The Shared Resources dialog box appears.    The Sharename box lists the shared 
resources available on the computer.

3. To view the users connected to a shared resource, select a share name from the Share 
Name box.    
The Connected Users box lists the connected users.

4. Optionally, to disconnect one user from all shared resources, select the user name 
from the Connected Users box and then choose the Disconnect button.    To disconnect 
all users from all shared resources, choose the Disconnect All button.    
Warn connected users before disconnecting them.    Each disconnected user is 
disconnected from all shared resources on the computer (not just the resource 
selected in the Sharename box).

Note: While you are remotely administering another computer, your user account will be 
listed as a connected user for the IPC$ share.    It cannot be disconnected.

5. To exit choose the Close button, and then in the Properties dialog box choose the OK 
button.

See Also
Viewing User Sessions
Viewing Resources In Use
Sharing a Directory
Managing Properties for a Shared Directory
Special Shares



Viewing Resources In Use

To view a list of the computer's open shared resources
1. In the Server Manager window, double-click a computer name.
2. In the Properties dialog box, choose the In Use button.

The Open Resources dialog box appears.    The Opened By box lists the computer's 
open resources.

3. Optionally, to close an open resource, select that resource from the list and then 
choose the Close Resource button.    To close all open resources, choose the Close All 
Resources button.    Warn connected users before closing resources.

Note: While you are remotely administering another computer, your connection will be 
displayed here as an open named pipe.    It cannot be closed.

4. Optionally, choose the Refresh button to update the displayed information.
5. To exit choose the Close button, and then in the Properties dialog box choose the OK 

button.

See Also
Viewing User Sessions
Viewing Shared Resources
Sharing a Directory
Managing Properties for a Shared Directory
Special Shares



Managing Export Replication

Only servers running Windows NT Server can be set up as replication export servers; 
computers running Windows NT Workstation cannot.    
Make sure an appropriate logon account has been assigned to the Directory Replicator 
service before performing the following procedure.
To set up an export server
1. Use File Manager to create the subdirectories that will be exported.    These must be 

subdirectories of the replication From Path.
Optionally, to these subdirectories add the files that will be exported.    However, it is 
not necessary to add files at this time.    Once you set up replication, any files later 
added to these subdirectories will be exported automatically.    You can also later add 
additional subdirectories to the replication From Path.

2. In the Server Manager window, double-click the computer name of the replication 
export server.

3. In the Properties dialog box, choose the Replication button. 
4. In the Directory Replication dialog box, select the Export Directories option.
5. Optionally, to change the path from which subdirectories will be exported, type a local 

path in the From Path box.
6. To export subdirectories to a domain or computer, under Export Directories choose the 

Add button, and then complete the Select Domain dialog box that appears.    The 
domain name or computer name is added to the To List.

Note: By default, the To List contains a blank entry and this computer automatically 
exports to the local domain.    If any entries are added to the To List, the local 
domain is no longer exported to.    If necessary, the domain name must be explicitly 
added to the To List.

7. To stop exporting subdirectories to a domain or computer, under Export Directories, 
select the domain or computer from the To List, and then choose the Remove button.

8. To manage locks, stabilization, and subtree replication for the subdirectories exported 
from this computer, under Export Directories choose the Manage button, and then 
complete the dialog box that appears.

9. To exit, choose the OK button in the Directory Replication dialog box.
If it does not already exist, the system creates the special REPL$ share, required for 
export replication.    If it is not already running, the system starts the Directory 
Replicator service.

10. In the Properties dialog box, choose the OK button.

See Also
Assigning a Logon Account to the Directory Replicator Service
Managing Import Replication
Setting the Logon Script Path



Special Shares



Directory Replication

Directory replication is the duplication of a master set of directories from a server (called an
export server) to specified servers or workstations (called import computers) in the same or
other domains.    A server running Windows NT Server can be an export server, an import 
computer, or both.    A workstation can only be an import computer.
Replication simplifies the task of maintaining identical sets of directories and files on 
multiple computers, because only a single master copy of the data must be maintained.    
Once replication is set up, replication occurs each time a change is made to one of the files 
in a directory set for export.



Directory Replicator service

Before replication can occur, an appropriate logon account must be assigned to the 
Directory Replicator service of each computer that will participate in replication.
Use User Manager for Domains to create a domain user account that the Directory 
Replicator service will use to log on.    This account must have the Password Never Expires 
option selected, all logon hours allowed, and membership in the domain's Backup 
Operators group.
For each computer that will participate in replication, use Server Manager to configure the 
Directory Replicator service to start up automatically, and to log on using the user account 
described above.



Managing Import Replication

Any Windows NT computer can be set up as a replication import computer.    
Make sure an appropriate logon account has been assigned to the Directory Replicator 
service before performing the following procedure.
To set up an import computer
1. In the Server Manager window, double-click the appropriate computer name.
2. In the Properties dialog box, choose the Replication button. 
3. In the Directory Replication dialog box, select Import Directories.
4. Optionally, to change the path in which imported subdirectories will be stored, type a 

local path in the To Path box.
5. To import subdirectories from a domain or export server, under Import Directories 

choose the Add button, and then complete the Select Domain dialog box that appears. 
The domain name or computer name is added to the From List.

Note: By default, the From List contains a blank entry and this computer automatically 
imports from the local domain.    If any entries are added to the From List, the local 
domain is no longer imported from.    If necessary, the domain name must be 
explicitly added to the From List.

6. To stop importing subdirectories from an export server or domain, select the domain 
name or computer name in the From List, and then choose the Remove button.

7. To view a list of the subdirectories that have been imported to this computer, or to 
manage locks on those imported subdirectories, under Import Directories choose the 
Manage button, and then complete the dialog box that appears.

8. To exit, choose the OK button in the Directory Replication dialog box.
If it is not already running, the system starts the Directory Replicator service.

9. In the Properties dialog box, choose the OK button.

See Also
Assigning a Logon Account to the Directory Replicator Service
Managing Export Replication
Setting the Logon Script Path



Setting the Logon Script Path

A logon script is an optional file that runs each time a user logs on.    It can be a batch file 
(.BAT or .CMD filename extension) or an executable program (.EXE filename extension).    A 
logon script path is a local path to the directory where logon scripts are stored.    
When a server authenticates a logon request and that user account has a logon script 
assigned, the system locates the logon script by combining a local logon script path 
specified in Server Manager with a filename (and optionally a relative path) specified in 
User Manager.
For a domain, master copies of every logon script should be stored under one replication 
export directory of one domain controller, either the primary domain controller or a backup.
Copies of these master logon scripts should be replicated to the other servers of the 
domain.    Then, for every other domain controller, the path to imported logon scripts must 
be entered in the Logon Script Path box of the Directory Replication dialog box.
For computers running Windows NT Workstation, the logon script path cannot be changed 
from the default (usually, systemroot\SYSTEM32\REPL\IMPORT\SCRIPTS).
To configure the logon script path for a server
1. In the Server Manager window, double-click the computer name of the server.
2. In the Properties dialog box, choose the Replication button.
3. In the Logon Script Path box, type a local path.

Usually, you will enter a path to a \SCRIPTS subdirectory of the replication To Path.    For
example,    C:\WINNT\SYSTEM32\REPL\IMPORT\SCRIPTS.
An entry is required.    Do not enter a blank in the Logon Script Path box.

4. To exit choose the OK button, and then in the Properties dialog box choose the OK 
button.

See Also
Managing Export Replication
Managing Import Replication



Managing Administrative Alerts

You can determine which users and computers are notified when administrative alerts 
occur at a selected computer.    Administrative alerts are generated by the system, and 
relate to server and resource use.    They warn about security and access problems, user 
session problems, server shutdown because of power loss when the UPS service is 
available, and printer problems.
To manage the recipients of administrative alerts
1. In the Server Manager window, double-click a computer name.
2. In the Properties dialog box, choose the Alerts button.
3. To add a user or computer to the list of alert recipients, type the user name or 

computer name in the New Computer Or User name box, and then choose the Add 
button.

4. To remove a user or computer from the list of alert recipients, select the user name or 
computer name from the Send Administrative Alerts To box, and then choose the 
Remove button.

5. To exit, in the Alerts dialog box choose the OK button, and then in the Properties dialog
box choose the OK button.



Viewing Shared Directories

To view the shared directories of a computer
1. Select a computer from the list in the Server Manager window.
2. From the Computer menu, choose Shared Directories.

The Shared Directory dialog box lists the shared directories of the computer, and 
shows the path of each shared directory.

3. To exit, choose the Close button.

See Also
Sharing a Directory
Managing Properties for a Shared Directory
Stopping Directory Sharing
Special Shares
Viewing Shared Resources
Viewing Resources In Use



Sharing a Directory

To share a directory
1. Select a computer from the list in the Server Manager window, and then from the 

Computer menu choose Shared Directories.
2. In the Shared Directories dialog box, choose the New Share button.
3. Type a Share Name, Path, and Comment in those boxes.
4. To define the maximum number of users who can connect to the shared directory at 

one time, select either Maximum Allowed or Allow.    If you select Allow, specify a 
maximum number in the Users box.

5. To manage the permission level granted to groups and user accounts, choose the 
Permissions button and complete the Access Through Share Permissions dialog box 
that appears.    Unless you change the default setting, a new shared directory provides 
Full Control to Everyone.

6. To exit, in the New Share dialog box choose the OK button, and then in the Shared 
Directories dialog box choose the Close button.

See Also
Stopping Directory Sharing
Setting Permissions for a Shared Directory
Viewing Shared Resources
Viewing Resources In Use



Managing Properties for a Shared Directory

To manage properties for a shared directory
1. Select a computer from the list in the Server Manager window, and then from the 

Computer menu choose Shared Directories.
2. In the Shared Directories dialog box, select a share name from the list.
3. Choose the Properties button. 
4. To change the Path or Comment, type new text in those boxes.
5. To change the maximum number of users who can connect to the shared directory at 

one time, select either Maximum Allowed or Allow.    If you select Allow, specify a 
maximum number in the Users box.

6. To change the permission level granted to groups and user accounts, choose the 
Permissions button and complete the Access Through Share Permissions dialog box 
that appears.

7. To exit, in the Share Properties dialog box choose the OK button, and then in the 
Shared Directories dialog box choose the Close button.

See Also
Setting Permissions for a Shared Directory
Special Shares
Sharing a Directory
Viewing Shared Resources
Viewing Resources In Use



Setting Permissions for a Shared Directory

Share permissions determine which users are allowed to access a shared directory, and the
type of access those users are allowed.    These permissions control network access to the 
shared directory, its subdirectories, and their files.    Share permissions are effective only 
when the shared directory is accessed over the network.
Permissions set on a share that is on an NTFS volume operate in addition to NTFS 
permissions set on the directory itself.    On NTFS volumes, share permissions specify the 
maximum access possible, while directory and file permissions specify the maximum 
access allowed.    For NTFS volumes it is usually better to restrict access by managing the 
permissions set on directories and files, rather than the permissions set on shares.
To set permissions for a shared directory
1. Select a computer from the list in the Server Manager window, and then from the 

Computer menu choose Shared Directories. 
2. In the Shared Directories dialog box choose the New Share button, or select a share 

name from the list and then choose the Properties button. 
3. Choose the Permissions button.
4. To change a permission, select a group or user account from the Name list, and then 

select a permission from the list in the Type Of Access box.
5. To add a group or user account to the list of those granted permissions for this shared 

directory, choose the Add button and complete the Add Users And Groups dialog box 
that appears.    
When assigning permissions it is usually better to assign permissions to groups, rather 
than to individual user accounts.

6. To remove a group or user account from the list of those granted permissions for this 
shared directory, select a group or user account from the Name list, and then choose 
the Remove button.

7. To exit, choose the OK button from the Access Through Share Permissions dialog box, 
choose the OK button again from the New Share or Share Properties dialog box, and 
then from the Shared Directories dialog box choose the Close button.

See Also
Types of Access Permissions
Special Shares
Sharing a Directory
Managing Properties for a Shared Directory



Stopping Directory Sharing

To stop sharing a directory
1. Select a computer from the list in the Server Manager window, and then from the 

Computer menu choose Shared Directories. 
2. In the Shared Directories dialog box, select a share name from the list.

In most cases you should not select one of the special shares which, if it appears in the
list, was created by the system (for example, A$, B$, C$, ADMIN$, IPC$, NETLOGON, 
PRINT$ or REPL$).

3. Choose the Stop Sharing button. 
The directory itself is not removed, but it is no longer shared and can no longer be 
accessed by network users.

4. To exit, choose the Close button.

See Also
Sharing a Directory
Managing Properties for a Shared Directory
Special Shares



Special Shares

A computer's shared resources include those resources (such as directories) that have been
shared by a user or an administrator, plus any special shares that may have been created 
by the system.
Depending on the configuration of the computer being administered, some or all of the 
following special shares may appear when Windows NT presents a list of the computer's 
shared resources.    These shares are created by the system.    In most cases, these special 
shares should not be deleted or modified.    For more information choose one of the 
following buttons.
   driveletter  $  
 ADMIN$
 IPC$
 NETLOGON
 PRINT$
 REPL$
See Also
Viewing Shared Directories
Viewing Shared Resources



driveletter$

A share which allows administrative personnel to connect to the root directory of a storage 
device.    Shown as A$, B$, C$, D$, and so on.    For example, D$ is a share name by which 
drive D might be accessed by an administrator over the network.
For a workstation or server, only members of the Administrators and Backup Operators can 
connect to these shares.    For a primary or backup domain controller, members of the 
Server Operators group can also connect to these shares.



ADMIN$

A resource used by the system during remote administration of a computer.    The path of 
this resource is always the Windows NT system root (the directory in which Windows NT is 
installed:    for example, C:\WINNT). 
For a workstation or server, only members of the Administrators and Backup Operators can 
connect to this share.    For a primary or backup domain controller, members of the Server 
Operators group can also connect to this share.



IPC$

A resource sharing the named pipes that are essential for communication between 
programs.    Used during remote administration of a computer, and when viewing a 
computer's shared resources.



NETLOGON

A resource used by the Net Logon service of a server running Windows NT Server while 
processing domain logon requests.    
Note: This resource is only provided for servers.    It is not provided for computers running 

Windows NT Workstation.



PRINT$

A resource that supports shared printers.



REPL$

A resource created by the system when a server is configured as an replication export 
server.    It is required for export replication.
Note: This resource is only provided for servers which are configured as replication export

servers.    It is not provided for computers running Windows NT Workstation.



Starting and Stopping Services

Use the Services dialog box to start, stop, pause, or continue each of the services available 
on the selected computer, and to pass startup parameters to the service.
Note: Because stopping the Server service disconnects all remote connected users, warn 

users before stopping that service.    Also, once the Server service is stopped, that 
computer can no longer be remotely administered, and its Server service can only 
be restarted locally.

To start, stop, pause, or continue a service
1. Select a computer from the list in the Server Manager window, and then from the 

Computer menu choose Services.
2. In the Services dialog box, select the service.
3. Choose the Start, Stop, Pause, or Continue button.

Optionally, to pass startup parameters to a service, type the parameters in the Startup
Parameters box before choosing the Start button. Backslashes are treated as an 
escape character. You must type two backslashes for each backslash in a parameter.

4. In the Services dialog box, choose the Close button.

See Also
Configuring Service Startup
The Default Services



Configuring Service Startup

To configure service startup, you must be logged on to a user account that has membership
in the Administrators local group.
To configure startup for a service
1. Select a computer from the list in the Server Manager window, and then from the 

Computer menu choose Services.
2. In the Services dialog box, select the service.
3. Choose the Startup button.
4. In the Service Startup dialog box, select a startup type of Automatic, Manual, or 

Disabled.
5. To specify the user account the service will use to log on, select System Account or 

This Account.

6. If you select This Account, also choose the Browse button  and specify a user 
account by completing the Add User dialog box that appears.
After closing the Add User dialog box, type the password for the user account in both 
the Password and Confirm Password boxes.

7. Choose the OK button, and then in the Services dialog box choose the Close button.

See Also
Assigning a Logon Account to the Directory Replicator Service
Assigning a Logon Account to the Schedule Service
The Default Services



Assigning a Logon Account to the Directory Replicator Service

Most aspects of directory replication are managed for a particular computer by using either 
the Server Manager Properties command or the Server option in Control Panel.
However, before a computer can participate in replication, you must create a special user 
account and then, for each computer in a domain that will participate in replication, 
configure its Directory Replicator service to log on using that special account.
To assign a logon account to the Directory Replicator service
1. Use User Manager for Domains to create a domain user account, configuring the 

account so that:
    The Password Never Expires option is selected.

    All logon hours are allowed.
    The user account has membership in the domain's Backup Operators group.

2. For each computer that will participate in replication, use Server Manager or the 
Services option in Control Panel to configure the computer's Directory Replicator service to 
start up automatically, and to log on using the user account you created in step 1.
See Also
Configuring Service Startup
The Default Services
Managing Export Replication
Managing Import Replication



Assigning a Logon Account to the Schedule Service

The Schedule service must be running if the AT command is to be used.    The AT command 
can schedule commands and programs to run on a computer at a specified time and date.   
By default, the Schedule service is configured to log on under the system account; the 
same account that is used by most services.    However, when the Schedule service logs on 
under the system account, the AT command can only be used to access those network 
resources that permit Guest access.
In many cases, if you want the AT command to access network resources, you must create 
a special user account and then configure the Schedule service to log on using that user 
account.
To assign a logon account to the Schedule service
1. Create a user account for the service using User Manager or User Manager for 

Domains.    When creating the account, select the Password Never Expires option.
2. Give the account membership in the appropriate groups.    The particular group 

memberships you assign will depend on the operations that must be accomplished 
remotely.    
For example, if the AT command is to be used to perform regularly scheduled backups 
of the hard disk of a remote server in a Windows NT Server domain, the user account 
created for the Schedule service must be a member of the domain's Backup Operators 
local group.

3. Assign the user account to the Schedule service using Server Manager or the Services 
option in Control Panel.

See Also
Configuring Service Startup
The Default Services



The Default Services

The services listed below are provided with Windows NT.    In addition to these default 
services, other services may be listed in the Services dialog box for a computer (for 
example, network transports or other services that have been installed on that computer).
For more information on the default services, choose one of the following buttons.
 Alerter
 Clipbook Server
 Computer Browser
 Directory Replicator
 Event Log
 Messenger
 Net Logon
 Network DDE
 Network DDE DSDM
 NT LM Security Support Provider
 Remote Procedure Call (RPC) Locator
 Remote Procedure Call (RPC) Service
 Schedule
 Server
 Spooler
 UPS
 Workstation
See Also
Starting and Stopping Services
Configuring Service Startup



Alerter service

Notifies selected users and computers of administrative alerts that occur on the selected 
computer.    Used by the Server and other services.    Requires the Messenger service.



Clipbook Server service

The Clipbook Server service supports the Clipbook Viewer application, allowing pages to be 
seen by remote Clipbooks.



Computer Browser service

Maintains an up-to-date list of computers, and provides the list to applications when 
requested.    Provides the computer lists displayed in the Select Computer and Select 
Domain dialog boxes; and in the main Server Manager window.



Directory Replicator service

Replicates directories, and the files in those directories, between computers.



Event Log service

Records system, security, and application events in the event logs.



Messenger service

Sends and receives messages sent by administrators or by the Alerter service.



Net Logon service

For primary and backup domain controllers, performs authentication of account logons, and
also keeps the domain's security database synchronized between the primary domain 
controller and the backup domain controllers of the domain.
For other Windows NT computers, supports pass through authentication of account logons.  
Used when the workstation participates in a domain.



Network DDE service

The Network DDE (Dynamic Data Exchange) service provides a network transport as well as
security for DDE conversations.



Network DDE DSDM service

The Network DDE DSDM (DDE Share Database Manager) service manages the shared DDE 
conversations. It is used by the Network DDE service.



NT LM Security Support Provider service

Provides Windows NT security to RPC applications that use transports other than named 
pipes.



Remote Procedure Call (RPC) Locator service

The Remote Procedure Call (RPC) Locator service allows distributed applications to use the 
Microsoft RPC name service. The RPC Locator service manages the RPC name service 
database.
The server side of a distributed application registers its availability with the RPC Locator 
service. The client side of a distributed application queries the RPC Locator service to find 
available compatible server applications.



Remote Procedure Call (RPC) service

The Remote Procedure Call (RPC) Service is the RPC subsystem for Microsoft Windows NT. 
The RPC subsystem includes the endpoint mapper and other miscellaneous RPC services.



Schedule service

The Schedule service must be running if the AT command is to be used.    The AT command 
can be used to schedule commands and programs to run on a computer at a specified time
and date.



Server service

Provides remote procedure call (RPC) support, and file, print, and named pipe sharing.



Spooler service

Provides print spooler services.



UPS service

Manages an uninterruptible power supply connected to this computer.



Workstation service

Provides network connections and communications.



Sending a Message to Connected Users

Use the Send Message command to send a message to all users who are connected to a 
computer.    You may want to do this before you administer the computer with Server 
Manager, particularly if you will be disconnecting one or more users, or if you will be 
stopping the Server service on that computer.
To send a message to connected users
1. Select a computer from the list in the Server Manager Window.
2. From the Computer menu, choose Send Message.
3. Type your message in the Message box.
4. Choose the OK button.



Promoting a Backup Domain Controller to Primary Domain 
Controller

To promote a backup domain controller to primary domain controller
1. Select a backup domain controller from the list of computers in the Server Manager 

window.    Choose a computer that is capable of reliably handling high network traffic 
loads.

2. From the Computer menu, choose Promote To Primary Domain Controller.
If it is available, the former primary domain controller is demoted to backup domain 
controller status.



Demoting a Primary Domain Controller to Backup Domain 
Controller

Usually, when a server is promoted to primary domain controller, no special action needs to
be taken to demote the former primary domain controller to backup domain controller 
status, because the system does this automatically.
However, if a server is promoted to primary domain controller while the existing primary 
domain controller is unavailable (for example, if it is being repaired), and if the former 
primary domain controller later returns to service, you must demote it.
To demote a primary domain controller to backup domain controller 
1. Select the former primary domain controller from the list of computers in the Server 

Manager window.
On the Computer menu, the Promote To Primary Domain Controller command changes,
becoming the Demote To Backup Domain Controller command.

2. From the Computer menu, choose Demote to Backup Domain Controller.

See Also
Promoting a Backup Domain Controller to Primary Domain Controller



Synchronizing a Backup Domain Controller with the Primary 
Domain Controller

Synchronization is usually done automatically by the system, but if the security database 
on a Windows NT Server computer becomes unsynchronized, or if a LAN Manager 2.x 
server is unable to establish network connections, there is a manual way to correct the 
situation.    It is rarely necessary.
(Note that you can synchronize a LAN Manager 2.x server only with a LAN Manager 2.x 
primary domain controller; you cannot synchronize a LAN Manager 2.x server with a 
Windows NT Server primary domain controller.)
To synchronize a backup domain controller with the primary domain controller
1. Select the server from the list in the Server Manager window.
2. From the Computer menu, choose Synchronize with Primary Domain Controller.

See Also
Synchronizing All Servers of the Domain



Synchronizing All Servers of the Domain

Synchronizing is usually done automatically by the system, but if the security database 
becomes unsynchronized between the primary domain controller and the other domain 
servers, there is a manual way to correct the situation.    It is rarely necessary.    It can take 
a substantial amount of time to complete.
To synchronize all the servers of the domain
1. Select the primary domain controller from the list in the Server Manager window.
2. From the Computer menu, choose Synchronize Entire Domain.

The domain's security database is replicated from the primary domain controller to all 
the servers of the domain.

See Also
Synchronizing a Server with the Primary Domain Controller



Adding a Computer to the Domain

To add a computer to a domain, you must be logged on to a user account that is a member 
of the Administrators, Domain Admins, or Account Operators group of that domain.
To add a computer to a domain
1. From the Computer menu, choose Add To Domain.
2. In the Add Computer to Domain dialog box, select either the Windows NT Workstation 

or Server option or the Windows NT Primary or Backup option.
3. Type the computer name in the Computer Name box.
4. Choose the Add button.

In the domain's security database, an account is added for that computer name.
5. Choose the Close button.

The computer is added to Server Manager's list.    However, until the computer joins 
the domain (as described in step 6), in Server Manager's list the computer's icon is 
dimmed and its version number and description are absent.

6. After a computer has been added, instruct the user of that computer to join the 
domain.    
For workstations and servers this can be done either while installing Windows NT on 
the computer, or after installation using the Network option of that computer's Control 
Panel.    For domain controllers, this can only be done during installation.

Note: Treat an added computer name as a security element.    Until the intended 
computer joins the domain, it is possible for a user to give a different computer that 
computer name, and then have it join the domain using the computer account you 
have just created.    If the added computer is a server, when it joins it receives a 
copy of the domain's security database.

See Also
Add To Domain



Removing a Computer from the Domain

After a computer is removed from a domain, it can no longer participate in domain security. 
The computer's account is deleted from the domain's security database.
To remove a computer from the domain
1. Select a computer from the list in the Server Manager window.

Do not select the primary domain controller.    It cannot be removed.
2. From the Computer menu, choose Remove From Domain.
3. Instruct the user of that computer to remove this domain name from the Network 

option in Control Panel, and to enter (as appropriate) another domain name or 
workgroup name.



Changing a Computer Name

To change a computer name
1. From the Computer menu, choose Add To Domain and complete the Add Computer To 

Domain dialog box, specifying the new computer name.
2. Instruct the user of that computer to change the computer name in the Network option

in Control Panel.
3. Select the old computer name from the list in the Server Manager window, and then 

from the Computer menu, choose Remove From Domain.

See Also
Adding a Computer to the Domain
Removing a Computer from the Domain



Services

Use the Services dialog box to start, stop, pause, or continue each of the services available 
on the selected computer, and to pass startup parameters to the service.    For more 
information, choose one of the following buttons.
 Service
 Status
 Startup
 Start button
 Stop button
 Pause button
 Continue button
 Startup button
 Startup Parameters
See Also
Starting and Stopping Services
Configuring Service Startup
The Default Services



Service

One service at a time can be selected.    Once selected, a service can be stopped, started, 
paused, continued, or configured for startup.



Status

The status of a service can be:
Started
Paused
Stopped (represented by a blank entry)



Startup

The startup type of a service can be
Automatic (service starts every time the system starts)
Manual (service can be started by a user or a dependent service)
Disabled (service cannot be started)



Start button
To start a service that is stopped, select the service, and then choose the Start 

button.    
Optionally, to pass startup parameters to the service, type text in the Startup 

Parameters box before choosing the Start button.



Stop button
To stop a service that is running, select the service, and then choose the Stop button. 

If another service is dependent on the service you stop, you will be warned before the action
completes.
Note: Because stopping the Server service disconnects all remote connected users, warn 

users before stopping that service.    Also, once the Server service is stopped, that 
computer can no longer be remotely administered, and its Server service can only 
be restarted locally.



Pause button
To pause a service that is running, select the service, and then choose the Pause 

button.



Continue button
To return to normal operation a service that has been paused, select the service, and 

then choose the Continue button.



Startup button

To configure service startup you must be logged on to a user account that has membership 
in the Administrators local group.

To specify the startup type of a service or to assign a logon account to a service, 
select the service, choose the Startup button, and complete the dialog box that appears.



Startup Parameters
To pass startup parameters to a service, select the service, type the parameters in 

the Startup Parameters box, and then choose the Start button. Backslashes are treated as 
an escape character. You must type two backslashes for each backslash in a parameter.



Service Startup

Use the Service Startup dialog box to configure when and how the service is started, and to
specify the user account the service uses to log on.    For more information, choose one of 
the following buttons.
 Startup Type
 Automatic
 Manual
 Disabled
 Log On As
 System Account
 This Account
 Browse button
 Password and Confirm Password
See Also
Configuring Service Startup
Assigning a Logon Account to the Directory Replicator Service
Assigning a Logon Account to the Schedule Service
The Default Services



Startup Type
To specify the startup behavior of the service, choose Automatic, Manual, or Disabled.



Automatic

Automatic services start every time the system starts.
Note: The Server service will not start automatically unless the computer has at least 

12MB of random-access memory.



Manual

Manual services can be started by a user or by a dependent service.



Disabled

Disabled services cannot be started by users, nor by dependent services.



Log On As

When services start, they log on.    
Most services must log on to the system account.    Usually, of the default services provided
with Windows NT only the Directory Replicator and Schedule services log on using other 
user accounts.



System Account

When services start, they log on.    Most services must log on using the system account.



This Account

Select this option to assign a logon user account to a service.
When services start, they log on.    Although most services must log on to the system 
account, some services can be configured to log on to special user accounts.    (Usually, of 
the default services provided with Windows NT, only the Directory Replicator and Schedule 
services will be configured in this manner.)
A user account used to log on a service should be created in User Manager specifically for 
that purpose.    Make certain that the user account has the Password Never Expires option 
selected, and has membership in the appropriate groups.    The particular group 
memberships assigned will depend on the operations that must be accomplished by the 
service.



Browse button 
To specify the user account the service will log on to, select This Account, choose the 

Browse button, and then complete the Add User dialog box that appears.    



Password and Confirm Password
In the Password box, type the password for the user account entered in This Account 

box.    Type the same password in the Confirm Password box.    
This is the password that was assigned to the user account in User Manager.    

Remember, passwords are case sensitive.



Stopping Dependent Services

The listed services are dependent on the service that you are stopping.    If you choose the 
OK button, both the selected service and its dependent services will be stopped.



Properties

Use the Properties dialog box to view and manage the server properties of the selected 
computer.    For more information, choose one of the following buttons.
 Usage Summary
 Sessions
 Open Files
 File Locks
 Open Named Pipes
 Description
 Users button
 Shares button
 In Use button
 Replication button
 Alerts button
See Also
Managing Server Properties



Usage Summary

This box contains summaries of connections and resource usage for the selected computer.



Sessions

The number of users remotely connected to the computer.



Open Files

The number of files opened by connected users.



File Locks

The number of file locks by connected users.



Open Named Pipes

The number of open named pipes.
A named pipe is an interprocess communication mechanism that allows one process to 
communicate with another local or remote process.



Description

The description can be any text.    It might typically contain such information as the location
of the computer, the name of the computer's user, the user's telephone extension, the 
brand or model of the computer, or a description of the computer's function.
The description is an optional entry and can be left blank.



Users button
Choose the Users button to view a list of all the users connected over the network to 

the computer, and for one selected user, a list of all open resources.
Optionally, you can disconnect one or all of the users who are connected to the 

computer.



Shares button
Choose the Shares button to view a list of the computer's shared resources, and for 

one selected resource, a list of all the connected users.    Optionally, you can disconnect one 
or all of the users who are connected to the computer.
Note: To share directories or manage shared directories, use the Shared Directories 

command from Server Manager, or use File Manager.    To share printers or manage 
shared printers, use Print Manager.



In Use button
Choose the In Use button to view a list of the computer's open shared resources.    
Optionally, you can close one open resource or all open resources.



Replication button

Directory replication exports copies of selected directories and files from this computer for 
storage on other computers, and imports selected directories and files from other 
computers for storage on this computer.    Servers running Windows NT Server can export 
and import.    computers running Windows NT Workstation can only import.

Choose the Replication button to manage directory replication for the computer.    For 
a server, also choose the Replication button to specify the path to user logon scripts.



Alerts button

Administrative alerts are generated by the system and relate to server and resource use.    
They warn about security and access problems, user session problems, server shutdown 
because of power loss when the UPS service is available, and printer problems.    For 
example, an alert is generated when disk space becomes low.    You can determine which 
users and computers are notified when administrative alerts occur at the computer.

Choose the Alerts button to view and manage the list of users and computers that 
are notified when administrative alerts occur at the computer.



User Sessions

Use the User Sessions dialog box to view a list of all the users connected over the network 
to the computer, and a list of all the resources opened by a selected user.    Optionally, you 
can disconnect one or all of the users connected to the computer.    For more information, 
choose one of the following buttons.
 Connected Users
 Computer
 Opens (for Connected User)
 Time (for Connected User)
 Idle
 Guest
 Number of Connected Users
 Resource
 Opens (for Resource)
 Time (for Resource)
 Disconnect button
 Disconnect All button
See Also
Viewing User Sessions
Special Shares



Connected Users    

This column lists the users who are connected to the computer over the network.    
Each entry consists of a user account icon, followed by a user name.    In some cases the 
user's computer name may be displayed instead of the user name.



Computer

The computer name of the connected user's computer.



Opens

The number of resources opened on this computer by this user.



Time

The hours and minutes that have elapsed since this session was established.



Idle

The hours and minutes that have elapsed since this user last initiated an action.



Guest

Whether this user is connected to this computer as a guest.    Shown as Yes or No.



Connected Users

The total number of users remotely connected to the computer.



Resource

This column lists the shared resources to which the selected user is connected.    Each entry
consists of an icon indicating the type of resource, followed by the share name. A shared 
resource could be:

A shared directory
A named pipe
A shared printer
A communication-device queue (Microsoft LAN Manager servers only)
A resource of an unrecognized type

In some cases, a connection to a printer is monitored here as a connection to a named 
pipe.



Opens

For the selected user, the number of opens from the listed resource.



Time

The hours and minutes that have elapsed since this user first connected to the shared 
resource.



Disconnect button
To disconnect one user from the computer, select a user name from the Connected 

Users list, and then choose Disconnect.    
Warn users before disconnecting them.    If you do not, they may lose data.

Note: While you are remotely administering another computer, your user account is listed
as a user connected to the IPC$ resource.    It will not be disconnected.



Disconnect All button
To disconnect all users from the computer, choose Disconnect All.    
Warn users before disconnecting them.    If you do not, they may lose data.

Note: While you are remotely administering another computer, your user account is listed
as a user connected to the IPC$ resource.    It will not be disconnected.



Shared Resources

Use the Shared Resources dialog box to view a list of the shared resources available on the 
computer, and for a selected resource, a list of connected users.    Optionally, you can 
disconnect one or all of the users connected to the computer.    
Note: To share directories or manage shared directories, use the Shared Directories 

command from Server Manager, or use File Manager.    To share printers or manage 
shared printers, use Print Manager.

For more information, choose one of the following buttons.
 Sharename
 Uses
 Path
 Connected Users
 Time
 In Use
 Number of Connected Users
 Disconnect button
 Disconnect All button
See Also
Viewing Shared Resources
Special Shares
Sharing a Directory
Managing Properties for a Shared Directory
Stopping Directory Sharing



Sharename

This column lists the shared resources available on the computer.    Each entry consists of 
an icon representing the type of shared resource, followed by the share name.    A shared 
resource could be:

A shared directory
A named pipe
A shared printer
A communication-device queue (Microsoft LAN Manager servers only)
A resource of an unrecognized type

In some cases, a connection to a printer is monitored here as a connection to a named 
pipe.



Uses

The number of connections to the shared resource.



Path

The path of the shared resource.



Connected Users    

This column lists the users who are connected to the selected shared resource.    Each entry
consists of a user account icon, followed by a user name.    In some cases the user's 
computer name may be displayed instead of the user name.



Time

The hours and minutes that have elapsed since the user first connected to the selected 
shared resource.



In Use

Whether the user currently has a file open from the selected shared resource (shown as Yes
or No).



Connected Users

The total number of users connected to the selected shared resource.



Disconnect button
To disconnect one user from all shared resources, select the user name from the list 

of Connected Users, and then choose Disconnect.    
Warn users before disconnecting them.    If you do not, they may lose data.

Note: While you are remotely administering another computer your user account is listed 
as a connected user for the IPC$ share.    It will not be disconnected.



Disconnect All button
To disconnect all users from all shared resources, choose Disconnect All.    
Warn users before disconnecting them.    If you do not, they may lose data.

Note: While you are remotely administering another computer your user account is listed 
as a connected user for the IPC$ share.    It will not be disconnected.



Open Resources

Use the Open Resources dialog box to view a list of the computer's open shared resources. 
Optionally, you can close one open resource or all open resources.    For more information, 
choose one of the following buttons.
 Open Resources
 File Locks
 Opened By
 For
 Locks
 Path
 Refresh button
 Close Resource button
 Close All Resources button
See Also
Viewing Resources In Use
Special Shares
Sharing a Directory
Managing Properties for a Shared Directory
Stopping Directory Sharing



Open Resources

The total number of resources that are open on the computer.



File Locks

The total number of file locks on open resources.



Opened By

This column lists the computer's open resources.    Each entry consists of an icon 
representing the type of resource, followed by the user name (or sometimes the computer 
name) of the user who has opened the resource.    An open resource could be:

A file
A named pipe
A print job in a print spooler
A communication-device queue (Microsoft LAN Manager servers only)
A resource of an unrecognized type

In some cases, a print job is shown here as an open named pipe.



For

The permission granted when the resource was opened.



Locks

The number of locks on the resource.



Path

The path of the open resource.



Refresh button
To update the display with current information. choose the Refresh button.



Close Resource button
To close one resource, select a resource from the list of open resources, and then 

choose the Close Resource button.    
Warn connected users before closing resources.    If you do not, they may lose data.

Note: While you are remotely administering another computer your connection is 
displayed here as an open named pipe.    It will not be closed.



Close All Resources button
To close all resources that are open on the computer, choose the Close All Resources 

button.    
Warn connected users before closing resources.    If you do not, they may lose data.

Note: While you are remotely administering another computer your connection is 
displayed here as an open named pipe.    It will not be closed.



Password

You must provide a valid password to administer a LAN Manager 2.x server that is using 
share-level security.



Alerts

Use the Alerts dialog box to view and manage the list of users and computers that are 
notified when administrative alerts occur at the selected computer.    Administrative alerts 
are generated by the system, and relate to server and resource use.    They warn about 
security and access problems, user session problems, server shutdown because of power 
loss when the UPS service is available, and printer problems.
For alerts to be sent, the Alerter and Messenger services must be running on the computer 
originating the alert.    For alerts to be received, the Messenger service must be running on 
the destination computer.    For more information, choose one of the following buttons.
 New Computer or User name
 Send Administrative Alerts To
 Add button
 Remove button
See Also
Managing Administrative Alerts



New Computer Or User Name
To add a user or computer to the list of alert recipients, type the user name or 

computer name in the New Computer Or User name box, and then choose the Add button.



Send Administrative Alerts To

This box lists the computers and users who are notified when administrative alerts occur at 
this computer.



Add button
To add a user or computer to the list of alert recipients, type the user name or 

computer name in the New Computer Or User name box, and then choose the Add button.



Remove button
To remove a user or computer from the list of alert recipients, select the user name or

computer name in the Send Administrative Alerts To box, and then choose the Remove 
button.



Send Message

Use the Send Message dialog box to send a message to all users who are connected to the 
selected computer.    You may want to do this before you administer the computer with 
Server Manager, particularly if you will be disconnecting one or more users, or if you will be
stopping the Server service on that computer.
For a message to be sent and received, the Messenger service must be running on the 
computer sending the message and on the computers receiving the message.
Message

In the Message box, type the text of your message.
See Also
Sending a Message to Connected Users



Add Computer to Domain

Before a Windows NT computer can be a domain member and participate in domain 
security, it must be added to the domain.    Computers that are added to a domain are 
given accounts in the domain's security database.    There are three ways to add computers
to a domain, but only one of them requires Server Manager.    That method uses the Add 
Computer To Domain dialog box.

A computer can be added to a domain during installation of Windows NT, but only 
when the installation is performed by a domain Administrator.

An Administrator can add an existing Windows NT computer to a domain using the 
Network option of that workstation's Control Panel.

Or, an Administrator or an Account Operator can use Server Manager's Add Computer
To Domain dialog box to add a computer account to the domain's security database.    Then 
the computer's user must have the computer join the domain under that computer account.  
This can be accomplished by a user as part of Windows NT installation; or, for any computer 
other than a primary or backup domain controller, after installation by using the Network 
option in Control Panel.
Note: Treat the added computer name as a security element.    Until the intended 

computer joins the domain, it is possible for a user to give a different computer that 
computer name, and then have it join the domain using the computer account you 
have just created.    If the added computer is a server, when it joins it receives a 
copy of the domain's security database.

For more information, choose one of the following buttons.
 Windows NT Workstation or Server
 Windows NT Primary or Backup
 Computer Name
 Add button
See Also
Adding a Computer to the Domain



Windows NT Workstation or Server

If the computer runs Windows NT Workstation, or runs Windows NT Server but is not a 
primary or backup domain controller, select this option.



Windows NT Primary or Backup

If the computer is a domain controller with Windows NT Server installed, select this option.



Computer Name

A unique name of up to 15 characters by which the computer will be known to the network. 
The name cannot be the same as any other computer or domain name in the network.
You can type a name using both uppercase and lowercase characters, but the name is 
displayed in uppercase, and Windows NT stores the name in uppercase.



Add button

Adds the computer name to the domain's security database.



Select Domain

When Server Manager starts, it displays your logon domain.    Use the Select Domain 
command to display a different domain, a Windows NT workgroup, or an individual 
computer.
For more information, choose one of the following buttons.
 Domain
 Select Domain
 Low Speed Connection
See Also
Selecting a Domain
Using Low Speed Connection
Who Can Use Server Manager?



Domain
To display a domain, type the domainname in the Domain box and then choose the 

OK button.    
To display a Windows NT workgroup, type the workgroupname in the Domain box and

then choose the OK button.    
To display only one computer, type the \\computername (precede computer names 

with two backslashes) and then choose the OK button.



Select Domain
To display one of the listed domains, select that domain name from the Select 

Domain list and then choose the OK button.



Low Speed Connection

When selecting a domain, workgroup, or computer that communicates with your computer 
across a connection providing relatively low transmission rates, select the Low Speed 
Connection option.    This option prevents automatic refreshes of the Server Manager 
screen, which may be time consuming when performed across low speed connections.    
(These refreshes occur automatically after some Server Manager functions, such as 
changing computer properties, managing services, or promoting a server to primary 
domain controller.)    When the Low Speed Connection option is selected, the Server 
Manager screen can still be refreshed manually by choosing the Refresh command from the
View menu.
For example, from a server running Windows NT Server you might administer a remote 
Windows NT Workstation computer that is running the Microsoft Windows NT Remote 
Access Service and is connected to the network by a modem over telephone lines.    When 
entering the computer name in Server Manager's Select Domain dialog box, you should 
select the Low Speed Connection option.
Low Speed Connection can also be selected (or cleared) by choosing the Low Speed 
Connection command from the Options menu.



Add User

Use the Add User dialog box to select the user account the service will use to log on.    
This should be a user account created in User Manager specifically for logging on the 
service.    Make certain that the user account has the Password Never Expires option 
selected, and has membership in the appropriate groups.    The particular group 
memberships assigned will depend on the operations that must be accomplished by the 
service.    Usually, of the default services provided with Windows NT, only the Directory 
Replicator and Schedule services have a user account assigned in this manner.
For more information, choose one of the following buttons.
 List Names From
 Names
 Add button
 Search button
 Add Name



List Names From

The List Names From box shows the domain or computer from which the user account can 
be selected.    The groups of that domain or computer are listed in the Names box.
When an asterisk (*) appears next to a domain or computer name in the List Names From 
box, it indicates that the local groups of that domain or computer can be listed in the 
Names box.    When the asterisk is absent, it indicates that local groups cannot be listed.

To change the selected domain or computer, select a domain name or computer 
name from the list in the List Names From box. 



Names

Lists the user accounts of the domain or computer selected in the List Names From box.



Add button

After a name is selected from the Names list, choosing Add places that name in the Add 
Name list.



Search button
To search for a particular user account, choose the Search button and complete the 

dialog box that appears.



Add Name

A user account can be added to this box by typing its name in the box; by selecting it from 
the Names box and choosing the Add button; or by choosing the Search button and 
completing the dialog box that appears.

To have the service log on using the account displayed in the Add Name list, choose 
the OK button.



Local Group Membership

The Local Group Membership dialog box lists the user accounts and global groups that are 
members of the selected local group.
Members Of

To add user accounts or global groups to the Add Names list in the Add User dialog 
box, here in the Local Group Membership dialog box select one or more names from the 
Members Of list, and then choose the OK button.
Members Button

To list the members of a global group (that is itself a member of this local group), 
select the global group from the Members Of list, and then choose the Members button.    



Global Group Membership

The Global Group Membership dialog box lists the user accounts that are members of the 
selected global group.
Members Of

To add user accounts to the Add Names list in the Add User dialog box, here in the 
Global Group Membership dialog box select one or more names from the Members Of list, 
and then choose the OK button.



Verify Synchronization

Synchronize with Primary Domain Controller reestablishes the computer's account 
password on both that computer and the primary domain controller.    This is usually done 
automatically by the system, but if the computer becomes unsynchronized and is unable to
establish network connections, this is a manual way to correct the situation.    It is rarely 
necessary.



Verify Domain Synchronization

Synchronize Entire Domain replicates the domain's security database from the primary 
domain controller to all the servers in the domain.    This is usually done automatically by 
the system, but if the databases become unsynchronized, this is a manual way to correct 
the situation.    It is rarely necessary.    It can take a substantial amount of time to complete.



Cannot Find Domain Controller

The domain controller for the specified domain could not be found.    You may have entered 
an incorrect domain name, the domain controller may be currently unavailable to the 
network, or the specified domain may not exist.



Warning, No Primary Domain Controller

The primary domain controller for this domain cannot be found.    Usually, during a 
promotion the domain security database of the old primary domain controller is replicated 
to the new primary domain controller.    Then the old primary domain controller is demoted 
to server status.    This ensures that the new primary domain controller receives the 
domain's latest security database.
If you proceed with the promotion at this time, this server's existing copy of the domain 
security database will be used.    It may or may not be up-to-date.    If you expect the 
primary domain controller to be available soon, it is a good idea to wait and to promote this
server at that time.



Verify Role Change

During a promotion, the domain security database from the old primary domain controller 
is replicated to the new primary domain controller.    Then the old primary domain controller
is demoted to backup domain controller status.    This operation can take several minutes.
Changing the role of a server ends all client connections to that server, including Remote 
Access connections. 
If you are currently working at a computer that is connected to the network through a 
Remote Access connection, and either the server you want to promote or the current 
primary domain controller is the Remote Access server for your current connection, then 
you cannot change the server's role successfully. This is because your Remote Access 
connection will be ended before the operation is complete.
If this is the case, you should end your current Remote Access connection and reconnect, 
using another Remote Access server. Or wait and perform this action when you are not 
using a Remote Access connection.



Close Resources

Closing resources can result in loss of data.    It is a good idea to send a warning to 
connected users before closing resources.
See Also
Sending a Message to Connected Users 



Close

Closing resources can result in loss of data.    It is a good idea to send a warning to 
connected users before closing resources.
See Also
Sending a Message to Connected Users 



Disconnect

Disconnecting users can result in loss of data.    It is a good idea to send a warning to 
connected users before disconnecting them.
See Also
Sending a Message to Connected Users 



Directory Replication

Use the Directory Replication dialog box to manage replication properties for the computer,
and to specify a local path to user logon scripts.    For more information, choose one of the 
following buttons.
 Do Not Export
 Export Directories
 Manage button (under Export Directories)
 From Path
 To List
 Do Not Import
 Import Directories
 Manage button (under Import Directories)
 To Path
 From List
 Add button
 Remove button
 Logon Script Path
See Also
Managing Export Replication
Managing Import Replication
Setting the Logon Script Path
Assigning a Logon Account to the Directory Replicator Service



Do Not Export

Prevents replication from this computer.    Subdirectories are not exported.



Export Directories

Enables replication from this computer.    Subdirectories of the From Path are exported.



Manage button (under Export Directories)

Displays the Manage Exported Directories dialog box, where export locks can be added or 
removed, and export stabilization and subtree export can be enabled or disabled. 



From Path

A local path to a directory from which subdirectories and files are exported.
The default From Path is systemroot\SYSTEM32\REPL\EXPORT.    Usually, you will not need to
change the default From Path.    



To List

Subdirectories are exported from this export server to the domains and computers of the To
List.
By default, the To List contains a blank entry and this computer automatically exports to 
the local domain.    If any entries are added to the To List, the local domain is no longer 
exported to.    If necessary, the domain name must be explicitly added to the To List.
Replication to a domain name does not always succeed when some or all import computers
of that domain are located across a wide area network (WAN) bridge from this export 
server.    In this situation, you must explicitly add the computer names of those import 
computers to the To List.



Do Not Import

Prevents replication to this computer.    Subdirectories are not imported.



Import Directories

Allows replication to this computer.    Subdirectories are imported.



Manage button (under Import Directories)

Displays the Manage Imported Directories dialog box, where import locks can be added or 
removed.



To Path

A local path to a directory in which imported subdirectories and files are stored.
The default To Path is systemroot\SYSTEM32\REPL\IMPORT.    Usually, you will not need to 
change the default To Path.



From List

Subdirectories are replicated to this import computer from the domains and computers of 
the From List.
By default, the From List contains a blank entry and this computer automatically imports 
from the local domain.    If any entries are added to the From List, the local domain is no 
longer imported from.    If necessary, the domain name must be explicitly added to the 
From List.
Replication from a domain name does not always succeed when export servers of that 
domain are located across a wide area network (WAN) bridge from this import computer.    
In this situation, you must explicitly add the computer names of those export servers to the
From List.



Add button

Displays the Select Domain dialog box.
The Add button under Export Directories is used to add a computer name or domain name 
to the To List.    
The Add button under Import Directories is used to add a computer name or domain name 
to the From List.



Remove button

Removes a selected computer name or domain name from the list.
The Remove button under Export Directories is used to remove a computer name or 
domain name from the To List.    
The Remove button under Import Directories is used to remove a computer name or 
domain name from the From List.



Logon Script Path

A local path to a directory where logon scripts are stored.    When a server authenticates a 
logon request and that user account has a logon script assigned, the system locates the 
logon script by combining the local path specified here, with a filename (and optionally a 
relative path) specified in User Manager.
For a domain, master copies of every logon script should be stored under one replication 
export directory of a primary or backup domain controller.    Copies of these logon scripts 
should be replicated to the other servers of the domain.    Then, for every other domain 
controller, the local path to imported logon scripts should be entered here, in the Logon 
Script Path box.    
Usually, you will enter a path to a \SCRIPTS subdirectory of the replication To Path.    For 
example, systemroot\SYSTEM32\REPL\IMPORT\SCRIPTS.
An entry is required.    Do not enter a blank in the Logon Script Path box.



Directory Replication

Use the Directory Replication dialog box to manage replication properties for the computer. 
For more information, choose one of the following buttons.
 Do Not Import
 Import Directories
 Manage button
 To Path
 From List
 Add button
 Remove button
See Also
Managing Import Replication
Assigning a Logon Account to the Directory Replicator Service



Add button

Displays the Select Domain dialog box.    Used to add a computer or domain to the From 
List.



Remove button

Removes a selected computer or domain from the From List.



Manage Exported Directories

Use the Manage Exported Directories dialog box to add or remove export locks, and to 
enable or disable export stabilization and subtree export. 
For more information, choose one of the following buttons.
 Export Path
 Subdirectory
 Locks
 Stabilize
 Subtree
 Locked Since
 Export Settings For
 Add Lock button
 Remove Lock button
 Wait Until Stabilized
 Entire Subtree
 Add button
 Remove button



Export Path

The path to the directory from which subdirectories and files are exported.



Subdirectory

A list of the subdirectories that are exported from this computer.
When a subdirectory is created in the export path (using File Manager or the command 
prompt), it is automatically added to this list.



Locks

The number of locks applied to the subdirectory.
A lock prevents subdirectory export, and more than one lock might be applied to a 
subdirectory.    Export occurs only if this column has a value of zero.



Stabilize

Yes indicates that all files and subdirectories in that subdirectory tree must be stable 
(cannot be changed) for two minutes (or more) before replication can occur.    No indicates 
that each file can be replicated as soon as it is changed.
The default is No.    To change this setting, use the Wait Until Stabilize check box.



Subtree

Yes indicates that the entire subdirectory tree will be exported.    No indicates that only the 
first-level subdirectory will be exported.    
The default is Yes.    To change this setting, use the Entire Subtree check box.



Locked Since

The date and time that the oldest lock was placed on this subdirectory.



Export Settings For

Shows the name of the selected subdirectory.



Add Lock button

Adds a lock to the selected subdirectory, preventing export.



Remove Lock button

Removes a lock from the selected subdirectory.    Export only occurs when a subdirectory 
has zero locks. 



Wait Until Stabilized

If selected, no changes can occur for two minutes (or more) to any subdirectory or file in 
the selected subdirectory tree before replication can occur.    Helps to eliminate partial 
replication.    If cleared, each file can be replicated as soon as it is changed.    
This setting is reflected in the Stabilize column.



Entire Subtree

If selected, the first-level export subdirectory and its files will be exported, along with all its 
subdirectories and their files.    If cleared, only the first-level export subdirectory and its files
will be exported.    
This setting is reflected in the Subtree column.



Add button

Displays the Add Subdirectory dialog box, used to add new subdirectories to the list of 
exported subdirectories.
However, this is usually unnecessary because it only adds an entry to the list, and does not
actually create the subdirectory.    When a subdirectory is created in the export path (using 
File Manager or the command prompt), it is automatically added to the list.



Remove button

Removes the selected subdirectory from the list of exported subdirectories.
However, this is usually unnecessary because it only removes the entry in the list, not the 
actual subdirectory.    If that subdirectory still exists in the export path, it will still be 
exported and will later reappear in this list.



Manage Imported Directories

Use the Manage Imported Directories dialog box to add or remove import locks.    For more 
information, choose one of the following buttons.
 Import Path
 Subdirectory
 Locks
 Status
 Last Update
 Locked Since
 Import Settings For
 Add Lock button
 Remove Lock button
 Add button
 Remove button



Import Path

The path to the directory in which replicated subdirectories and files are stored.



Subdirectory

A list of the replicated subdirectories that are imported to this computer. 
A subdirectory is automatically imported if it is exported by one of the export servers or 
domains in the From List of the Directory Replication dialog box.    If it is imported, it is 
automatically added to this list.



Locks

A lock prevents import to the subdirectory.    More than one lock might be applied to a 
subdirectory.    Import to a subdirectory only occurs if this column has a value of zero.



Status
"OK" indicates that the subdirectory is receiving regular updates from an export 

server and the imported data is identical to that exported.
"No Master" indicates that the subdirectory is not receiving updates.    The export 

server might not be running, or the export server might have stopped exporting updates.
"No Sync" indicates that the subdirectory has received updates, but the data is not 

up to date.    This could be due to a communications failure, open files on the import 
computer or export server, the import computer not having access permissions at the export
server, or an export server malfunction.

A blank entry indicates that replication has never occurred for that subdirectory.    
Replication may not be properly configured for this import computer, for the export server, 
or both.



Last Update

The date and time that the last update was made to a file in this import subdirectory, or in 
its subtree.



Locked Since

The date and time that the oldest lock was placed on this subdirectory.



Import Settings For

Shows the name of the selected subdirectory.



Add Lock button

Adds a lock to the selected subdirectory, preventing import.



Remove Lock button

Removes a lock from the selected subdirectory.    Import only occurs when a subdirectory 
has zero locks. 



Add button

Displays the Add Subdirectory dialog box, used to add new subdirectories to the list of 
imported subdirectories.
However, this is usually unnecessary because this only adds an entry to the list, and does 
not create the actual subdirectory.    When a subdirectory is exported by one of the export 
servers or domains in the From List of the Directory Replication dialog box, it is 
automatically imported and added to this list.



Remove button

Removes the selected subdirectory from the list.
However, this is usually unnecessary, because this only removes the entry from the list, 
and does not remove the actual subdirectory.    If that subdirectory is exported by one of the
export servers or domains in the From List of the Directory Replication dialog box, it will still
be imported and will later reappear in this list.



Add Subdirectory

Use the Add Subdirectory dialog box to add a subdirectory to the Subdirectory list.    
However, this is usually unnecessary, since this action only adds an entry to the list and 
does not create the actual subdirectory.    Instead, use File Manager or the command 
prompt to create export subdirectories on export servers.    On import computers, imported 
subdirectories are automatically created the first time they are received from an exporting 
server.
Path
This is either the import path or the export path.
Subdirectory Name

To add a subdirectory to the list, type its name in the Subdirectory Name box, and 
then choose the OK button.



Select Domain

Use the Select Domain dialog box to select a domain or a computer to be added to the 
replication From List or the replication To List.
Replicating to or from a domain name is a convenient way to set up directory replication 
between many computers, because each export server and import computer can specify 
only a few domain names for export or import, rather than a long list of many computer 
names.
Domain
This box displays the current domain.    You can type a domainname or a \\computername 
here.
Select Domain
This box lists the available domains.    If you double-click on a domain name, the computers 
in that domain are listed.    You can select one of the listed domains or computers.



Shared Directories

A shared directory can be accessed by network users.    Use the Shared Directories dialog 
box command to share, stop sharing, modify properties of, and manage permissions for 
shared directories.    For more information, choose one of the following buttons.
 Shared Directories On
 New Share button
 Properties button
 Stop Sharing button
See Also
Sharing a Directory
Managing Properties for a Shared Directory
Stopping Directory Sharing
Special Shares
Viewing Shared Resources
Viewing Resources In Use



Shared Directories On

This box lists the shared directories of the computer, and shows the path of each.
The list consists of those resources that have been shared by a user or an administrator, 
plus any special shares that may have been created by the system (for example, A$, B$, 
C$, ADMIN$, IPC$, NETLOGON, PRINT$ or REPL$).



New Share button
To share a directory, select the New Share button and complete the New Share dialog

box that appears.



Properties button
To view or manage the properties of a shared directory, select the shared directory 

from the Share Directories On list, choose the Properties button, and then complete the 
Share Properties dialog box that appears.



Stop Sharing button
To stop sharing a directory, select the shared directory from the Share Directories On 

list, and then choose the Stop Sharing button.
The directory itself is not removed, but it is no longer shared and can no longer be 

accessed by network users.



New Share

Use the New Share dialog box to share a directory.    A shared directory can be accessed by 
network users.    For more information, choose one of the following buttons.
 Share Name
 Path
 Comment
 User Limit
 Maximum Allowed
 Allow
 Users
 Permissions button
See Also
Sharing a Directory
Setting Permissions for a Shared Directory



Share Name

The name used to identify and connect to this share.    Share names can have up to 12 
characters.    
If computers running MS-DOS will be connecting to this share, share names should be 
limited to 8 characters, optionally followed by a period and up to 3 more characters.



Path

The path of a local directory to be shared.    For example, you might type c:\sales\
budgets.



Comment

Any text describing the shared directory.    Users see this comment when connecting to the 
shared directory using File Manager.
This is an optional entry.



User Limit

Defines the maximum number of users who can connect to the shared directory at one 
time.



Maximum Allowed

There is no limit on connections to this shared directory. There may be a limit, however, on 
how many users can connect to this computer overall.



Allow

Only the number of users specified in the Users box can connect at one time to the shared 
directory.



Users

The maximum number of network users who can connect at one time to the shared 
directory.



Permissions button

Permissions determine which users are allowed to access the shared directory, and the 
type of access those users are allowed.    The default is to grant Full Control to Everyone.

To manage permissions for the shared directory, choose Permissions and complete 
the Access Through Share Permissions dialog box that appears.



Share Properties

Use the Share Properties dialog box to view and manage the path, comment, user limit, or 
permissions for the selected shared directory.    For more information, choose one of the 
following buttons.
 Share Name
 Path
 Comment
 User Limit
 Maximum Allowed
 Allow
 Users
 Permissions button
See Also
Managing Properties for a Shared Directory
Setting Permissions for a Shared Directory
Special Shares
Viewing Shared Resources
Viewing Resources In Use



Share Name

The name of the selected shared directory.



Access Through Share Permissions

Share permissions determine which users are allowed to access a shared directory, and the
type of access those users are allowed.    These permissions control network access to the 
shared directory, its subdirectories, and their files.    Share permissions are effective only 
when the shared directory is accessed over the network.
Permissions set on a share that is on an NTFS volume operate in addition to NTFS 
permissions set on the directory itself.    On NTFS volumes, share permissions specify the 
maximum access possible, while directory and file permissions specify the maximum 
access allowed.    For NTFS volumes it is usually better to restrict access by managing the 
permissions set on directories and files, rather than the permissions set on shares.
Use the Access through Share Permissions dialog box to add, remove, or change share 
permissions assigned to groups or user accounts.    For more information, choose one of the
following buttons.
 Share Name
 Owner
 Name
 Type of Access
 Add button
 Remove button
See Also
Types of Access Permissions
Setting Permissions for a Shared Directory



Share Name

The shared directory for which permissions are being managed.



Owner

The owner of the shared directory.



Name

The Name box lists the groups and user accounts granted permissions for this shared 
directory, and shows the type of access granted to each.



Type Of Access

The Type Of Access box lists the permissions that can be granted to the groups and user 
accounts listed in the Name box.

To change the type of access granted to a group or user account, select the group or 
user account from the Name box, and then select a permission from the Type Of Access list.



Add button
To add a group or user account to the list of those granted permissions for the shared

directory, choose the Add button and complete the Add Users and Groups dialog box that 
appears.



Remove button
To remove a group or user account from the list of those granted permissions for the 

shared directory, select the group or user account from the Name box, and then choose the 
Remove button.



Invalid Local Path

You must provide an absolute path for the directory to be shared.    It must be a path local 
to computer that is being administered.    
For example, you might create a share named INVOICES with a path of C:\SHIPPING\
INVOICE.



Invalid Share Name

The share name is a name used to identify and connect to this share.    Share names can be
up to 12 characters.    If computers running MS-DOS will be connecting to this share, share 
names should be limited to 8 characters, optionally followed by a period and up to 3 more 
characters.



 Cannot Change Share Path

By default, some special shares are provided by the system, and the paths for these special
shares cannot be changed.
However, the comment, user limit, and permissions can be changed.



Share Name not Accessible from MS-DOS

Share names can be up to 12 characters.    If computers running MS-DOS will be connecting 
to this share, share names should be limited to 8 characters, optionally followed by a 
period and up to 3 more characters.



Current Users Warning

You should warn connected users before disconnecting them.
You have issued the Stop Sharing command against a share to which users are connected 
and have open files.    If you choose OK and continue, the connected users may lose data.    



Add Users and Groups

Use the Add Users And Groups dialog box to add groups or user accounts to the list of those
granted permissions for the shared directory.    For more information, choose one of the 
following buttons.
 List Names From
 Names
 Add button
 Show Users button
 Members button
 Search button
 Add Names
 Type of Access
See Also
Types of Access Permissions
Setting Permissions for a Shared Directory



List Names From

The List Names From box shows the domain or computer from which groups and user 
accounts can be selected.
When an asterisk (*) appears next to a domain or computer name in the List Names From 
box, it indicates that the local groups of that domain or computer can be listed in the 
Names box.    When the asterisk is absent, it indicates that local groups cannot be listed.

To change the selected domain or computer, select a domain name or computer 
name from the list in the List Names From box. 



Names

Lists the groups of the domain or computer selected in the List Names From box.    If Show 
Users has been selected, it also lists the user accounts.



Add button

After a name has been selected from the Names list, choosing Add places that name in the 
Add Names list.



Show Users button

By default only groups of the selected domain or computer are listed in the Name box.
To also show user accounts in the Name box, choose Show Users.



Members button
To list the members of a group, select the group from the Names list, and then 

choose the Members button.    



Search button
To search for a particular group or user account, choose the Search button and 

complete the dialog box that appears.



Add Names

Groups and user accounts can be added to this box by typing their names (separated by 
semicolons) in the box; by selecting them from the Names box and choosing the Add 
button; by choosing the Search button and completing the dialog box that appears; or by 
selecting a group from the Names box, choosing the Members button, and completing the 
dialog box that appears.

To add the names in the Add Names list to the list of names granted permissions for 
the shared directory, choose the OK button.



Type Of Access
To specify the permission to be granted to all the groups and user accounts listed in 

the Add Names box, select a permission from the Type Of Access list.



Local Group Membership

The Local Group Membership dialog box lists the user accounts and global groups that are 
members of the selected local group.
Members Of

To add user accounts or global groups to the Add Names list in the Add Users and 
Groups dialog box, here in the Local Group Membership dialog box select one or more names
from the Members Of list, and then choose the OK button.
Members Button

To list the members of a global group (that is itself a member of this local group), 
select the global group from the Members Of list, and then choose the Members button.    



Global Group Membership

The Global Group Membership dialog box lists the user accounts that are members of the 
selected global group.
Members Of

To add user accounts to the Add Names list in the Add Users And Groups dialog box, 
here in the Global Group Membership dialog box select one or more names from the 
Members Of list, and then choose the OK button.



Find Account

Use the Find Account dialog box to locate a particular user account or group.    For more 
information, choose one of the following buttons.
 Find User or Group
 Search All
 Search Only In
 Search button
 Search Results
 Add button



Find User Or Group
In this box, type the name you want to search for. 
The system will search only for user accounts or groups of that exact name.



Search All

When selected, this option causes the search to look for a matching user or group name in 
the local domain or computer, and in all domains trusted by the local domain.



Search Only In

When selected, this option causes the search to look for a matching user or group name 
only in the domains and computers you have selected from the list.    
The list includes the local domain or computer, and all domains trusted by the local 
domain.



Search button

Begins a search based on the parameters specified in the Find User Or Group box, and by 
the Search All or Search Only In options.



Remote Administration not Supported for Shared Directories

The shared directories of the selected computer cannot be remotely administered.    This 
may be because the required, special IPC$ share does not exist at that computer.



Invalid Share Permissions

You must enter any combination of the letters RWCXDAP, with no duplicates.
R (read) 
W (write) 
C (create) 
D (delete) 
X (execute) 
A (change attributes) 
P (change permissions)



Invalid Share Comment

The entered comment is not valid.    Enter a new comment.



Invalid Share Path

You must provide an absolute path for the directory that is to be shared.    It must be a path 
local to computer that is being administered.    
For example, you might create a share named INVOICES with a path of C:\SHIPPING\
INVOICE.



Invalid User Limit

The entered user limit is not valid.    Enter a new user limit.



Invalid Path for Special Share

ADMIN$ or IPC$ are special shares.    Usually, they are created automatically by the system. 
If you create one of these shares using the New Share dialog box, complete only the Share 
Name box.    Leave the Path and Comment boxes empty.



Invalid Comment for Special Share

ADMIN$ or IPC$ are special shares.    Usually, they are created automatically by the system. 
If you create one of these shares using the New Share dialog box, complete only the Share 
Name box.    Leave the Comment and Path boxes empty.



New Share Password

You are administering a shared directory of a LAN Manager 2.x server that is running share-
level security, and you have specified a new password for the share.    A user will need to 
provide the new password in order to connect to this share.
If this is what you intended, choose the OK button; if not, choose the Cancel button.



Shared Directory Path Change Warning

You have entered a new path for an existing shared directory.    In effect, you are stopping 
sharing of the existing shared directory, and are sharing another directory under the 
existing share name.
If this is what you intended, choose the OK button; if not, choose the Cancel button.



Cannot Set Permissions

Server Manager cannot set permissions on a LAN Manager server running user-level 
security.



Password for Shared Directories Administration

You are attempting to administer the shared directories of a LAN Manager 2.x server that is 
running share-level security.    You must provide a password valid for the special ADMIN$ 
share on that server.



Share Permissions

Use the Share Permissions dialog box to set the access type and password for the selected 
share.    For more information, choose one of the following buttons.
 Access Type
 Read Only
 Change
 Other
 Password



Access Type

You set one set of permissions for the selected shared directory.    These permissions apply 
to everyone who uses the directory.



Read Only

Users can read and copy files, run programs, change from one subdirectory to another 
within the shared directory, and read the extended attributes of files.



Change

Users have RWCXDA permissions.
R (read) 
W (write) 
C (create) 
D (delete) 
X (execute) 
A (change attributes) 



Other

To specify permissions other than read or change, enter any combination of the letters 
RWCXDAP, with no duplicates.

R (read) 
W (write) 
C (create) 
D (delete) 
X (execute) 
A (change attributes) 
P (change permissions)



Password

Enter a password for this shared directory.    Users must provide this password in order to 
access the directory.    A password can have as many as 14 characters.



Cannot Find Server

The specified server cannot be located.



Find Account

Use the Find Account dialog box to locate a particular user account or group.    For more 
information, choose one of the following buttons.
 Find User or Group
 Search All
 Search Only In
 Search button
 Search Results
 Add button



Search Results

Contains a list of user accounts and groups found during a search.    This list is continuously 
filled as a search progresses. 
One or more names can be selected from the Search Results list, and then added to the 
Add Name list of the Add User dialog box by choosing the Add button here in the Find 
Account dialog box.
The list presents the matching users in the form domainname\user name (full name) 
description or computername\user name (full name) description.
The list presents the matching groups in the form domainname\groupname description or 
computername\groupname description.



Search Results

Contains a list of user accounts and groups found during a search.    This list is continuously 
filled as a search progresses. 
One or more names can be selected from the Search Results list, and then added to the 
Add Names list of the Add Users And Groups dialog box by choosing the Add button here in 
the Find Account dialog box.
The list presents the matching users in the form domainname\user name (full name) 
description or computername\user name (full name) description.
The list presents the matching groups in the form domainname\groupname description or 
computername\groupname description.



Add button

Closes the Find Account dialog box, and adds the accounts selected in the Search Results 
list to the Add Name list of the Add User dialog box.



Add button

Closes the Find Account dialog box, and adds the accounts selected in the Search Results 
list to the Add Names list of the Add Users And Groups dialog box.



Types of Access Permissions

For information on the types of access permissions that can be applied to shared 
directories, choose one of the following buttons.
Note: When a directory is shared, the default is to grant the special Everyone group Full 

Access permissions.
 No Access
 Read
 Change
 Full Control
See Also
Setting Permissions for a Shared Directory



No Access

Prevents any access to the shared directory, its subdirectories, and their files.



Read

Allows:
Viewing filenames and subdirectory names. 
Traversing to subdirectories. 
Viewing data in files.
Running application files. 



Change

Allows:
Viewing filenames and subdirectory names. 
Traversing to subdirectories. 
Viewing data in files. 
Running application files. 
Adding files and subdirectories. 
Changing data in files. 
Deleting subdirectories and files. 



Full Control

This is the default permission applied to any new shares you create.    It allows:
Viewing filenames and subdirectory names. 
Traversing to subdirectories. 
Viewing data in files. 
Running application files. 
Adding files and subdirectories. 
Changing data in files. 
Deleting subdirectories and files. 
Changing permissions (NTFS files and directories only). 
Taking ownership (NTFS files and directories only). 



Demoting a Remote Access Server

Changing the role of a server ends all client connections to that server, including Remote 
Access connections. 
If you are currently working at a computer that is connected to the network through a 
Remote Access connection, and the primary domain controller that you want to demote is 
the Remote Access server for your current connection, then you cannot change the server's
role successfully. This is because your Remote Access connection will be ended before the 
operation is complete.
If this is the case, you should end your current Remote Access connection and reconnect, 
using another Remote Access server. Or wait and perform this action when you are not 
using a Remote Access connection.



Changing the Role of a Remote Access Server

Changing the role of a server ends all client connections to that server, including Remote 
Access connections. 
If you are currently working at a computer that is connected to the network through a 
Remote Access connection, and either the server you want to promote or the current 
primary domain controller is the Remote Access server for your current connection, then 
you cannot change the server's role successfully. This is because your Remote Access 
connection will be ended before the operation is complete.
If this is the case, you should end your current Remote Access connection and reconnect, 
using another Remote Access server. Or wait and perform this action when you are not 
using a Remote Access connection.




